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~graffiti « LEGEND , Aug 31, 2017 Aug 31, 2017 Sorry. Hadn't been in there in a while. So now it's Settings>Advanced>Privacy and security>Content settings>PDF Documents. Turn off "Download PDF files instead of automatically opening them in Chrome". Jump to answer S. S * Adobe Employee , Apr 22, 2025 Apr 22, 2025 Hi @kent 1933, Hope
you are doing well. Sorry for the trouble. The below settings (as also shared above) should be optimal for web browsers to work as per instructions. However, if this is not how it works, have you checked if you can open the file in Acrobat> File menu> Save As. Doing so should launch the MacOS finder window for you to select the location and save
the file on your computer. Let us know if this is not what you see, and we can troubleshoot further. Regards,Souvik. Jump to answer If your PDF won’t open, it’s most likely your file is corrupted. You will get “Failed to load PDF document” or “Adobe Acrobat Reader could not open ‘XYZ.pdf’ because it is either not a supported file type or because the
file has been damaged” messages when opening a document. In such instances, your best bet is to re-download the file or ask others to send the PDF again. However, if needed, you might as well have to repair the corrupted file. But, for users who did not receive such errors, other factors like large file size, incorrect file password, incompatibility with
PDF Reader, enabled Protected Mode, etc could be the culprit. To troubleshoot these problems, I'll walk you through these proven fixes. If your PDF file was not downloaded completely or some malware affected it, the file might have been corrupted. When your system detects such suspicious files, the antivirus software or built-in Defender will not
allow the file to open. So, re-download the file and try to open it again. But, in case the problem persists, you need to ask the sender to share that file again. Tip: You can also check whether a file is safe for downloading or not. Are you sure the file you are trying to open is a PDF file? There are chances that the files might have been mislabeled as .pdf
extension but is not actually a PDF file. To verify, check the file properties. For that, right-click on the PDF file and choose Properties. On the General tab, look for the Type of file menu. Is the password correct? In order to open a password-protected file, you must enter the correct PIN/passcode. If the file does not open, maybe the password you've
entered is wrong. You can also confirm this with the sender or author of the PDF and try again. If you still experience the same issue even after downloading the file again, your only option is to repair the corrupted file. Some online tools like Adobe Acrobat Reader, iLovePDF, etc offer to repair such files. But, this does not guarantee your file will be
fixed fully. Depending on the case your PDF is damaged, the tools can help you to recover the file either partially or completely. On Windows, Microsoft Edge is the default viewer which is why the PDF files will always load in the browser. But, if there is a problem with your browser, PDF fails to open. In that case, you can right-click on the PDF file
and open it with PDF Reader on your PC. It should definitely load on any one of the platforms as long as the file is not corrupted. Moreover, if you’'re able to access the file, you can also set that PDF Reader as the default to view the files in that app at all times. Right-click on the PDF file. Go to Open with > Choose another app. Select PDF Reader and
click on Always use this app to open the PDF files box. Another reason why your PDF won’t open is when the file size is too big for your PC to process. The file might even take a lot of time to download. If that is the case, you need to reduce the file size. To do so, visit any Compress PDF online and upload your file. Then, download the new compressed
PDF and open it. Using an outdated PDF Reader could be another reason why the app is not opening the files. So, update the most recent version. It may have new security updates and bug fixes. As an example, I'll take a reference to update Adobe Acrobat. For that, go to Adobe Acrobat. From the Menu, navigate to Help > Check for updates option.
If there is an update, click on the Update button. Wait for a few minutes and restart your computer to refresh the changes. You can also reinstall the PDF reader. If the piled-up and corrupted cache data are causing the issue, deleting the app will clear them out. To delete the app, enter Windows + I for Settings. Go to Apps > Installed Apps. Next to
PDF Reader, click the More icon > Uninstall. Download the PDF Reader app from the Microsoft Store again. Then, double-click the PDF file to see. It is not always the case that there’s a fault in the PDF file. There could be compatibility issues between your PDF Reader and device that causes the program to not work properly. For Instance, in Adobe
Acrobat, you can set the compatibility mode Properties. Locate Adobe Acrobat Reader. Right-click on the app and select Properties. Go to the Compatibility tab and click on Run this program in compatibility mode for. Select the Older Windows version. Click on Apply and close the window. Sometimes, third-party extensions or Ad-Blockers in web
browsers can cause PDF files to not open. So, you can switch to Incognito Mode and open the PDF links. As all extensions are disabled in the Incognito Mode, your file should open. When you attempt to open a large PDF file with too many tabs running in the browser, the file might not load because of not enough memory. To address this, close all the
unnecessary tabs in your browser. I would also recommend you end the background apps from the Task Manager. Since it troubleshoots high CPU usage issues, your system will have enough resources to open the file. If PDF files are not opening on your Adobe Reader, maybe the Protected Mode at Startup feature is blocking it. The app does this
when it detects suspicious or malicious data in the file that can affect your system. You can temporarily turn off the protected mode and try to open the file. Warning: Disable the Protected Mode at Startup feature only if you are sure that the file won’t be harmful to your device. Go to Adobe Reader. Enter the Ctrl + K keyboard shortcut for the
Preferences window. Navigate to Security (Enhanced) menu and uncheck the box for Enable Protected Mode at the startup. To confirm changes, hit the OK button. Quick Tips Standard users will need admin credentials to run programs as administrators. You can also use the Adobe Acrobat extension in Microsoft Edge to open PDF files with Acrobat
features. Adobe Acrobat Reader and Adobe Acrobat Reader DC are the same and include Document Cloud (DC) integration. Before starting the fixes, please note that Adobe Acrobat Reader DC and Adobe Acrobat Reader are the same now. When we discussed this with the Adobe support team, they explained that “DC” means Document Cloud and this
functionality is integrated into the current version of Adobe Acrobat Reader. Step 1: Right-click the Acrobat Reader DC shortcut on your desktop and click Run as Administrator. In the User Account Control dialog box that appears, click Yes. Step 2: If Acrobat Reader DC launches appropriately, configure the shortcut to run the program with
administrative rights. Start by right-clicking the Acrobat Reader DC shortcut. Then, click Properties. Step 3: Switch to the Shortcut tab > click the Advanced button. Now, check the box for Run as administrator and apply the changes in the Advanced Properties pop-up. Is Acrobat Reader DC still failing to open? Ending all background processes
related to the program can help. It will ensure that it gets a fresh start. Step 1: Open Task Manager using Ctrl + Shift + Esc and switch to the Processes tab. Step 2: Type Adobe Acrobat in the search box at the top. Step 3: It will only show you Adobe Acrobat-related processes. Right-click on each and select End task. Once done, open the Acrobat
Reader DC again. It should also resolve the full-screen issue on Acrobat Reader. Most files that we download from the Internet are blocked. You can unblock them from the properties window. Step 1: Right-click on the PDF file and select Properties. Step 2: Under the General tab, check the box for Unblock. Step 3: Apply the changes, and when you
open the file, it should not have any issue with permission. Acrobat Reader DC uses Protected Mode to secure your computer against malicious PDF documents. In rare instances, Protected Mode can also prevent the program from loading, especially if the certificates have issues; hence, try disabling it. Since you obviously can’t open Acrobat Reader
DC to disable Protected mode, you must use the Registry Editor. Step 1: Press Windows+R, type regedit, and click OK to open the System Registry. Step 2: Copy the following path into the address bar of the Registry Editor window and press Enter: Computer\HKEY CURRENT USER\SOFTWARE\Adobe\Acrobat Reader\DC\Privileged Step 3: Double-
click the registry entry labeled bProtectedMode. Step 4: Set the value to 0 and click OK. If you still have issues, you must reinstall Adobe Acrobat Reader DC. However, repairing Acrobat Reader is an excellent option before you do that. Step 1: Open Windows Settings (Win + I) and navigate to Apps. Step 2: Click the three-dot menu and select Modify
to launch the Adobe Acrobat repair module. Step 3: Click the Next button, select Repair, and click Next again. Step 4: Click the Update button. The installer will validate the installation, download the file if necessary, and replace the existing one. Step 5: Once completed, click the Finish button and open Adobe Acrobat to check if the issue has been
resolved. If this doesn’t work, use the same method but choose to uninstall it this time. Once done, reinstall the app and check if the issue is resolved. Last updated on 29 April, 2024 The article above may contain affiliate links which help support Guiding Tech. The content remains unbiased and authentic and will never affect our editorial integrity.
For the majority of Windows users, Adobe Acrobat is the go-to PDF viewer. It's easy to use, a great tool for creating PDFs, and you can edit, print, and allow others to access your collection. The software, however, sometimes acts up like any other app, so you may experience a variety of problems while using it. A common issue is when Adobe Acrobat
Reader DC won't open PDF files. As such, here are 12 fixes you can try to fix Adobe Acrobat Reader DC not being able to open PDF files. Before We Get Started... Before implementing any of the fixes, make sure the problem isn't occurring only with one PDF. Check any other file in the software. If all other files work fine, redownload the PDF or recall
it from the source you got it from earlier. When you are unable to open any of the PDF files, you can proceed to the below fixes. Many processes continue to run in the background even after we close the program. It means that closing and reopening Adobe Acrobat without closing these processes won't count as a fresh start. Therefore, you must close
all associated processes in the Task Manager before closing the main program and reopening it. Follow the below steps to do so: Right-click on the Windows Start button and select Task Manager. Find processes related to Adobe Acrobat. To end the process, right-click on it and select End task. Close all relevant tasks one by one, then close the main
program. Once everything is closed, open the PDF again using Adobe Acrobat. If the issue is not resolved, start implementing the following fixes. Whenever you run an app as an administrator, it has full access to all files of your operating system that would otherwise be restricted. As such, the first fix you should try is to run Adobe Acrobat Reader as
an administrator. If Windows is stopping Adobe from opening PDF files due to missing or corrupted permissions, running it as administrator will fix the issue. You can run Adobe Acrobat as an administrator by simply left-clicking on the icon and tapping Run as administrator. If the software is working well now and opening PDFs normally, consider
making this setting the default for Adobe Acrobat. Follow these steps to configure Adobe to run as an administrator by default: Right-click on the Adobe shortcut and go to Properties. Navigate to the Shortcut tab in the Properties window. Tap on Advanced. Check the box for Run as administrator and hit OK. Giving administrator privileges to
programs that aren't backed by trusted sources can be dangerous. Always be careful of which programs you grant administrative rights to. With the Windows compatibility mode, older versions of Windows can be used as operating systems. There might be some programs that work better with an older version of Windows than an updated one. If you
are using an Adobe version that is not compatible with the current version of Windows, run it in compatibility mode. To do so, follow these steps: Right-click on the Adobe Acrobat shortcut and go to Properties. Navigate to the Compatibility tab in the Properties window. Check the box for Compatibility mode. Choose any older Windows version from
the available options. Tap on Apply and hit OK. If compatibility were the problem, Adobe would begin opening PDF as usual. If not, make sure you turn off compatibility mode before implementing the rest of the fixes on this list. Adobe Acrobat may not open the PDF you're trying to read if it detects any infection. The software does this to prevent your
device from getting infected with viruses, which can wreak havoc on your computer. Considering that, you should ensure that the PDFs that failed to open in Adobe Acrobat are virus-free. There are several ways to check that, but here is the simplest: Go to VirusTotal's website. Go to the File tab, then click the Choose File button. Select the PDF file
Adobe failed to open and follow the on-screen instructions to confirm uploading the file. Wait for VirusTotal's virus scanner tool to finish processing. If the tool detects an infection in a file, you should delete it. Then, download a new copy of the same PDF, and Adobe Acrobat should open it without any problem. Protected Mode is a security feature
introduced in Reader 10.0 that protects users from viruses and attacks. This is a good thing for your security, but it sometimes misinterprets files as malicious and doesn't open them correctly. As such, you can try temporarily turning off this mode to see if it's preventing the software from opening PDFs. Here's how to do it: Press Win + R to open the
Run command. Type Regedit and tap Enter to open Registry Editor. Paste the following address into the Registry Editor. Computer\HKEY LLOCAL MACHINE\SOFTWARE\Policies\Adobe\Adobe Acrobat\DC\FeatureLockDown Right-click and navigate to New > DWORD Value. Rename the file to "bProtectedMode." Right-click the file and tap on Modify.
Change data value to O to disable Protected Mode. Run the PDF file again with Protected Mode off. Keep Protected Mode off if everything works well this time instead of having to turn it on/off many times throughout the day. Of course, this will compromise your security, so it's up to you to decide if it's worth keeping off! Adobe Acrobat sometimes
crashes or fails to open large PDF files, for instance, a document with thousands of pages. If the software cannot open a large PDF file, compress it to reduce size. Taking this step will ensure that the file size is not the problem. To compress a PDF file, follow these steps: Open the Compress PDF tool by Smallpdf. Click Choose Files and select the file
you wish to compress. Choose the type of compression and click Compress. Let the tool complete the compression process. Once done, download the compressed PDF file and open it using Adobe Acrobat to see if it opens successfully. Do you use an app other than Adobe Acrobat to open PDF files by default, and when you attempt to open them
manually in Adobe Acrobat, the app fails to do so? If that's the case, try making Adobe Acrobat your default app for opening PDF files to see if it successfully opens them this way. You can do that by following these steps: Right-click on any PDF file and select Properties. Go to the General tab and click the Change... button. Select Adobe Acrobat from
the list of apps and click Set default. Click Apply, then OK. In the presence of Potentially Unwanted Programs, some of the files of software and apps can get corrupted. Corrupted files cause Adobe Acrobat to malfunction. The common issues are improper file saving, crashing issues, and software not properly loading all PDFs. To make sure this isn't
an issue, repair Adobe Acrobat once. This will repair any corrupt files and reinstall any missing files. To repair Adobe Acrobat, follow these steps: Open Adobe Acrobat Reader DC. Navigate to the Help tab. Tap on Repair Installation. If the problem persists after repairing the software, check for any available updates. An outdated version of Adobe
Acrobat can also lead to such a problem. To do that, open Adobe Acrobat and navigate to Help > Check for Updates. Adobe will take some time to check for updates, and you can update to the latest version if it is available. In case none of the fixes work, you can reinstall the software. Before you reinstall the software, uninstall it and delete any of the
associated system files that might still be lurking inside your computer. To do this, go to Control Panel > Programs and Features. Once you have located Adobe Acrobat DC, right-click on it and choose Uninstall. Remove the associated system files by going to the below address on your computer and deleting each file.
C:\Users\\AppData\Local\Adobe\Acrobat Next, you'll need to reinstall the latest Adobe version from Adobe's website. Consider switching back to Adobe Acrobat's older version if you are still having trouble even after reinstalling it. When a new version of software comes out, it often brings tons of unexpected issues. You can always revert to an older
version of Adobe that isn't working correctly after an update. But before you do that, make sure you properly uninstall it. Once you're done uninstalling Acrobat, it's time to download an older version to see if that fixes your problem. Adobe lets you roll back your copy of Acrobat, and you can use third-party websites that host some older files; however,
make sure the source is legit before downloading. If none of the fixes have worked, ensure the hidden malware is not interrupting the program's operation. You can only do that by running a malware scan. There are several ways to perform a security check in Windows, but we recommend using Windows Defender Offline scan, which is easy to use
and free. If you have more than one PDF viewer app installed on your device and one such app is currently open, then inter-app interference could also cause the problem. To rule out this possibility, you should close all other PDF viewers, make Adobe Acrobat the default app to open PDFs, and open the file in the app. If you have followed the fixes
mentioned above, Adobe Acrobat should be able to open your PDFs again. If it doesn't work, don't worry! There are hundreds of other PDF viewers available. While the list is endless, we recommend you try PDFescape. In addition to being trendy, it is also considered one of the best alternatives to Adobe Acrobat.



